
Oracle  CorporateSync for Palm

User’s Guide

Release 2.1.4 for Macintosh

August, 2002

Part No.  B10105-01



Oracle CorporateSync for Palm User’s Guide, Release 2.1.4 for Macintosh 

Part No.  B10105-01

Copyright © 1999, 2002, Oracle Corporation. All rights reserved. 

The Programs (which include both the software and documentation) contain proprietary information of 
Oracle Corporation; they are provided under a license agreement containing restrictions on use and 
disclosure and are also protected by copyright, patent and other intellectual and industrial property 
laws. Reverse engineering, disassembly or decompilation of the Programs, except to the extent required 
to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems 
in the documentation, please report them to us in writing. Oracle Corporation does not warrant that this 
document is error-free. Except as may be expressly permitted in your license agreement for these 
Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, for any purpose, without the express written permission of Oracle Corporation.

If the Programs are delivered to the U.S. Government or anyone licensing or using the programs on 
behalf of the U.S. Government, the following notice is applicable:

Restricted Rights Notice  Programs delivered subject to the DOD FAR Supplement are "commercial 
computer software" and use, duplication, and disclosure of the Programs, including documentation, 
shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement. 
Otherwise, Programs delivered subject to the Federal Acquisition Regulations are "restricted computer 
software" and use, duplication, and disclosure of the Programs shall be subject to the restrictions in FAR 
52.227-19, Commercial Computer Software - Restricted Rights (June, 1987). Oracle Corporation, 500 
Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy, and other measures to ensure the safe use of such applications if the Programs are used for 
such purposes, and Oracle Corporation disclaims liability for any damages caused by such use of the 
Programs. 

Oracle is a registered trademark of Oracle Corporation. Other names may be trademarks of their 
respective owners.



Contents

Send Us Your Comments ..................................................................................................................    vii

1  Introduction to Oracle CorporateSync

A word about terms ................................................................................................................................    1
System Requirements ............................................................................................................................    1

2  Installing Oracle CorporateSync

Limitations ...............................................................................................................................................    2
Avoiding Problems .................................................................................................................................    3

3 Using Oracle CorporateSync

Synchronizing Your Palm Organizer for the First Time .................................................................    1

4 Troubleshooting

HotSync Problems ..................................................................................................................................    1
Entry Problems ........................................................................................................................................    2
Other Problems .......................................................................................................................................    5

5  Synchronization

Synchronizing Your Palm Organizer With Your Offline Agenda.................................................    1
Synchronizing your Palm organizer with your online and offline Agenda ...............................    1
                                                                                iii



6 Field Mapping

Entries........................................................................................................................................................    1
Tasks ..........................................................................................................................................................    3
Address Book Entries .............................................................................................................................   4
iv                                     



List of Tables

6–1 Calendar Application Entries and Palm Organizer Date Book Items ..............................    1
6–2 Calendar Server Tasks and Palm Organizer To Do Items..................................................    3
6–3 Calendar Application Address Book Entries and Palm Organizer Addresses ...............    5
6–4 Palm Organizer Business and Personal Entries ...................................................................    7
6–5 How Palm Organizer Telephone Numbers Transfer to the Calendar Application........    7
6–6 How Palm Organizer Telephone Numbers Transfer to the Calendar Application........    8
v



vi



Send Us Your Comments

Oracle CorporateSync for Palm User’s Guide, Release 2.1.4 for Macintosh

Part No.  B10105-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this 
document. Your input is an important part of the information used for revision.

■ Did you find any errors?
■ Is the information clearly presented?
■ Do you need more information? If so, where?
■ Are the examples correct? Do you need more examples?
■ What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document 
title and part number, and the chapter, section, and page number (if available). You can send com-
ments to us in the following ways:

■ Electronic mail: infodev_us.oracle.com 
■ FAX: (650) 633-3836   Attn: Oracle CorporateSync for Palm
■ Postal service:

Oracle Corporation 
Oracle Collaboration Suite Documentation Manager
500 Oracle Parkway, Mailstop 2op5
Redwood Shores, CA 94065
USA

If you would like a reply, please give your name, address, telephone number, and (optionally) elec-
tronic mail address.

 If you have problems with the software, please contact your local Oracle Support Services.
vii



viii



Introduction to Oracle Corporate
1

Introduction to Oracle CorporateSync

Oracle CorporateSync allows you to transfer data between your calendar 
application and your Palm compatible platform device. With CorporateSync 2.1.4, 
you can synchronize with Oracle CorporateTime 5.0 or greater. 

If you cannot find the installer file, contact your System Administrator. For 
information on HotSync setup, consult your Palm organizer handbook.

A word about terms
Calendar server refers to the server where all Entries (Meetings, Day Events, Daily 
Notes, Tasks and Holidays) exist. Calendar application refers to the application you 
use to create, edit or delete these Entries (CorporateTime, OpenTime, Netscape 
Calendar or Lexacom Calendar). In cases where Entries are discussed, calendar 
server and calendar application are used interchangeably. Where Address Books are 
discussed, only calendar application is used, as CorporateSync can only 
synchronize Address Books that exist locally on a user's machine and not on the 
server.

System Requirements
■ CorporateTime Server 2.53, 2.57, 2.60, 3.5x, 4.0 or greater, or Netscape Calendar 

Server 3.5 or greater 

■ Macintosh OS System 7.1.2 or greater 

■ 8 MB RAM minimum (64 MB recommended) 

■ Palm MacPac version 2 or greater 

■ Palm platform compatible device (e.g. Palm III, V, VII, or WorkPad) 
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Installing Oracle CorporateSync

1. If you already have data in your Palm Desktop, you should perform a HotSync 
before installing CorporateSync.

2. If you have a previous version installed on your computer, the installer will 
automatically locate it and overwrite it. 

3. This installation replaces the Palm Desktop with your calendar application 
Entry information. If you have data in the Palm Desktop, the installer will move 
it to a folder entitled Disabled Conduits. Turn on the Palm organizer and place 
it in its cradle.

4. Press the HotSync button on the front of the Palm organizer cradle. The CS 
Setup application will be installed on your Palm organizer.

5. If the HotSync Manager is running, the installer will ask if you wish to close it. 
Click Yes to exit the HotSync Manager.

6. Click the HotSync icon in your HotSync folder and select HotSync Manager. 

7. From the HotSync menu, choose Conduit Settings. A list of synchronizable items 
appears. Choose how you want CorporateTime Events, Tasks and Addresses to be 
synchronized by double-clicking on each item. A dialog box appears. 

■ Synchronize the files: Synchronize all information that exists on both your 
Palm organizer and in CorporateTime. 

■ Macintosh overwrites hand-held: Information in your CorporateTime Agenda 
overwrites Events, Tasks or Addresses on your Palm organizer. 

Note: You may get error messages in the HotSync log saying that 
CS Setup cannot be located. Ignore these messages.
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Limitations
■ Hand-held overwrites Macintosh: Information on your Palm organizer overwrites 
Entries, Tasks or Addresses on your Macintosh. 

■ Do Nothing: The specified Entry type is not synchronized. 

8. Select a user name from the top of the Conduit Settings dialog box. If there is 
only one user name, it will be selected automatically. For more information on 
the Conduit Settings dialog box, consult your Palm organizer Handbook.

CorporateSync is now installed but no Entry information has been synchronized. 

Limitations
■ Upgrading your Palm device to OS 3.3 may result in loss of data if you have a previous 

version of CorporateSync installed. To avoid this error, please install CorporateSync 
2.1.2 before you upgrade to OS 3.3. If you have already encountered this error, upgrade 
to CorporateSync 2.1.2 to resolve the problem. 

■ The Palm organizer does not recognize different time zones. Make sure your calendar 
application's time zone corresponds to the Palm organizer's.

■ You cannot synchronize the Palm organizer's repeating Events. You can, however, 
synchronize your calendar application's repeating Entries. 

■ If you change a timed Event to an untimed Event, or vice versa, on your Palm organizer, 
the change will not appear in your calendar application. 

■ It is recommended that you only synchronize the Palm organizer with your on-line 
Agenda. Synchronizing with the off-line Agenda can (and usually does) cause duplicate 
Entries. See Appendix A for details. 

■ You cannot HotSync Address Book Entries when your calendar application is open on 
your Macintosh. 

■ CorporateSync is unable to present a list of possible matches for duplicated names. To 
avoid this problem, enter as much unique user information as possible (e.g. organization 
unit, etc.). 

Note: CorporateSync does not require that a calendar application be 
installed on your machine. However, CorporateTime/OpenTime 4.0 or 
greater is required to synchronize an off-line Agenda or Address Book. 
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Avoiding Problems
Avoiding Problems
There are a few steps you can take to minimize potential problems: 

■ After you upgrade to CorporateSync 2.1.2, HotSync immediately before performing 
other operations 

■ When possible, create and modify your Entries using the calendar application. This is 
especially recommended when dealing with repeating Entries. 

■ Set the Private Records option in the Palm organizer's Security application to "Show". 

■ Choose Refresh all from the calendar application View menu after performing a 
HotSync. 

■ Select "Set as Default" in the Change HotSync Action menu to preserve the settings you 
entered. 
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Using Oracle CorporateSync

Synchronizing Your Palm Organizer for the First Time
1. Turn on your Palm organizer.

2. Tap the CS Setup icon to open CorporateSync Setup.

3. Enter your calendar application user name and/or organization units in the 
user field. Enter enough characters to distinguish yourself from all other users 
on your server. 

4. Enter the server name and node number or alias in the server field.

5. Synchronize with an off-line database by selecting Off-line instead of a server 
name. If you select Off-line, the server and node fields will disappear.

6. Enter your calendar server password. 

7. Choose Dates from the pick list at the top of your Palm organizer. Define the 
Synchronization period. Enter the range by entering From and To values or by entering 
start and end dates (or a combination of both). 

8. Choose Events from the pick list at the top of your Palm organizer and select Event 
options 

9. Select "HotSync Refused Entries" to transfer Meetings, Daily Notes and Day Events 
that you have chosen not to attend or keep in your Agenda 

10. Select "Show Location" to transfer Meeting Locations (the default Location is the first 
invited Resource) 

11. Select "Show Attendees" to transfer the names of invited people and Resources 
(maximum of 12) 
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Synchronizing Your Palm Organizer for the First Time
12. Select "Limit Event Details" to limit the size of Meeting Descriptions that will be 
transferred. When selected, enter the maximum size to be transferred (maximum of 
64k). 

13. Choose Tasks from the pick list at the top of your Palm organizer and select Task 
options. 

14. Select "HotSync Completed Tasks" to transfer Tasks marked as completed. 

15. Select "Limit Task Details" to limit the size of Task Comments that will be transferred. 
When selected, enter the maximum size to be transferred (maximum of 64k). 

16. Choose Addresses from the pick list at the top of your Palm organizer and enter the 
calendar application Address Book name. Select Address options. In order to HotSync 
Address Book Entries, your calendar application must be closed on your Macintosh. 

17. Place your Palm organizer into its cradle and press the HotSync button. Your Palm 
organizer is now synchronized with your calendar application. 
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Troubleshooting

This chapter explains how to work around problems users sometimes encounter 
while working with the Palm organizer. Bulleted lists represent various ways a 
problem can be fixed. You may need to use one, some or all of the possible 
solutions.

HotSync Problems
I cannot get my Palm organizer to HotSync with the calendar application.

■ Make sure your Macintosh's HotSync Manager is on. 

■ The calendar application cannot be open in off-line mode when you perform a HotSync 
with your off-line Agenda. Close the calendar application or switch on-line by choosing 
Work On-line from the File menu. 

■ If you are also synchronizing Address Book Entries, the calendar application must be 
closed. Ensure that the Address Book name is entered correctly in CS Setup. 

■ Close all HotSync windows on your Macintosh (e.g. HotSync Log, Custom menu). 

■ Verify the accuracy of the user name, organization units, password, server and node 
settings in the Palm organizer CS Setup. 

■ Make sure the user name, organization units and initials you entered distinguish you 
from everyone else on the system. 

■ Verify that your Palm organizer is placed properly in its cradle. 

■ Make sure the HotSync Custom settings for calendar application Addresses, Entries and 
Tasks are not set to "Do Nothing". 

■ Make sure the server you are connecting to is running properly. 
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Entry Problems
■ Verify the Serial Port settings using the Setup dialog box (opened when you click the 
HotSync manager icon near your Macintosh's Finder and choose Setup). Make sure no 
other programs are using the same Com Port as HotSync. 

■ Close the HotSync Manager and then open it again. 
I have trouble connecting to the server.

■ Make sure the user name, organization units, server name, password and node number 
have all been entered properly in the Palm organizer CS Setup. 

■ Make sure that you are using the right HotSync option in the HotSync 
application (Local Sync vs. Modem Sync).

■  Ensure that the server you are connecting to is running properly.

■  Verify that your Palm organizer is sitting properly in its cradle.

■  If you are synchronizing calendar application Addresses, your off-line and on-line 
passwords must be the same. 

The HotSync keeps timing out.

Open the Palm organizer's HotSync application. Hold down the Up and Down buttons and 
tap the top-right corner of the screen. The Developer's Back Door dialog box will open and 
the message "DLServer Wait Forever is ON" will appear. Tap OK. 

The HotSync is taking too long. 

Cut down the synchronization time by doing the following: 

■ Set unused applications to "Do Nothing" in the HotSync Manager Custom menu. 

■ Narrow the time period you want to HotSync in the Palm organizer CS Setup. 

Entry Problems
Some Palm organizer Entries do not appear in the calendar application after 
synchronizing. 

■ Choose Refresh all from the View menu in the calendar application. 

■ Only the first Event of a repeating Event created using the Palm organizer appears in the 
calendar application. 

■ The Entries are outside the range defined in the Palm organizer CS Setup. 

Some calendar application Entries do not appear in the Palm organizer after 
synchronizing. 
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Entry Problems
■ Set Private Records in the Palm organizer Security application to "Show". 

■ The Entries are outside the range defined in the Palm organizer CS Setup. 

■ Check the Entries and/or Tasks HotSync settings in the Palm organizer CS Setup. Select 
the desired options and HotSync again. 

What happens to an Entry that has been modified in both the calendar 
application and the Palm organizer when I perform a HotSync? 

■ When a HotSync is done and the Custom menu setting for the calendar 
application is "Synchronize the files", the Entry is duplicated (for more 
information about the duplication, open the HotSync Log). Simply delete the 
unwanted Entry (either on your Palm organizer or in the calendar application) 
and HotSync again. 

I changed a timed Event into an untimed Event (or vice versa) in my Palm 
organizer but the change was lost when I performed a HotSync. 

The calendar application does not support this kind of change. You must delete the Event 
and then create a new one for the calendar application to recognize it after the next HotSync. 

I created an untitled Event using the Palm organizer but I cannot find it. 

It was never created. Unless a Note or a Location (entered in the Palm organizer 
using parentheses on the time line) is included with an untitled Event, the Event 
will not be created. 

I keep getting multiple copies of my Entries.

■ If you modified an Entry in both the Palm organizer and the calendar application, 
Entries will be duplicated when you do a HotSync and the calendar application Events 
setting in the Custom menu is "Synchronize the files". Simply delete the unwanted 
Entry (either on your Palm organizer or in the calendar application) and HotSync again. 

■ This will happen when you synchronize your Palm organizer to your off-line Agenda 
and then reconcile your off-line Agenda with your on-line Agenda before synchronizing 
your Palm organizer and the on-line Agenda. See Appendix A for more information. 

■ If a HotSync stops with an unexpected error, power loss, etc., it is possible that some 
Entries will be duplicated the next time you HotSync. 

Changes I made to an Entry in my Palm organizer were not transferred to the 
calendar application. 

■ If it was an instance from a series of repeating Events, it will never be transferred to the 
calendar application. the calendar application only modifies the original Event. 

■ Change the calendar application setting in the Custom menu to "Synchronize the files". 
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Entry Problems
When I modify a repeating Event on my organizer that was created in the 
calendar application, some changes are applied to all instances, while others only 
to the modified instance. 

■ The Title, Location, Times and Reminder will only change in the instance you modify. 
Deleting an Event on the Palm organizer only deletes that one instance. To change these 
settings for all instances at once, you have to use the calendar application. Notes and 
Access Levels will be modified for all instances of the Event. 

I am having trouble with repeating Events created on my Palm organizer. 

The Palm organizer and the calendar application handle repeating Entries differently: 

■ Currently, the only way to have repeating Events appear in both the calendar application 
and the Palm organizer is to schedule them in the calendar application and HotSync. If 
you need to schedule repeating Events using your Palm organizer, you have to create 
each instance separately for them to appear in the calendar application. 

■ If you created repeating Events in the Palm organizer and the Custom menu setting for 
the calendar application is "Synchronize the files", only the first one will appear in the 
calendar application. All instances will remain in the Palm organizer. 

■ If you delete the first repeating Event in the Palm organizer, only the original Event will 
remain on your Palm organizer if your HotSync setting for calendar application Entries 
is "Desktop overwrites the Palm organizer". 

■ If you delete the lone instance that was transferred to the calendar application, all 
instances of that Entry will be deleted if your HotSync setting for the calendar 
application Events is not "Do Nothing". 

Events on my Palm organizer get rescheduled after I synchronize. 

It is important that the time you enter on your Palm organizer corresponds to the calendar 
application time zone entered in your calendar application. 

I want to delete all Events on my Palm organizer. 

■ Delete them manually or on an Entry-by-Entry basis. 

■ Set a time range in your Palm organizer's CS Setup where no Entries exist and 
synchronize with the calendar application HotSync settings set to "Desktop overwrites 
handheld" 

■ Perform a hard reset. Warning: Do this only if you want to delete Events from all 
user-installed applications on the Palm organizer, along with all information you have 
entered. Consult the Palm organizer Handbook for more information. 

I want to tell my Palm organizer what Address Book Entry address to keep 
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Other Problems
If you only have either the Business or Personal address entered in your calendar application 
Address Book, it will choose that one by default. If both addresses are entered, the Default 
address value selected in the Palm organizer CS Setup is used. 

How does my Palm organizer deal with my Address Book Entry phone numbers? 

Your Palm organizer tries to recognize phone numbers as best as it can. If it cannot find a 
valid international phone number combination, everything is entered in the calendar 
application phone number field. A blank space, dash or period can separate parts of the 
number. An x or # can be used to identify extensions. The following are examples of valid 
phone number combinations: 

There is an extra x or # beside some phone extension numbers on my Palm 
organizer. 

You probably entered the extra character in your calendar application Address Book. Open 
the Address Book and delete the extra character manually from the Extension edit box. The 
next time you HotSync the extra character will be gone. 

Other Problems
There is not enough space to enter my user name and organization units. 

It is long enough; the typing simply scrolls off-screen. To view all the characters on screen at 
once, open the Keyboard (CS Setup > Edit menu > Keyboard) and type the information 
there. 

Valid phone number combinations

555-5555

555 5555

(555) 555-5555

55 (555) 555-5555

555-555 #555

55.55.55.55

55-55-55

555-55-55

55 55 55 55x555
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Other Problems
My Palm organizer keeps freezing up. 

Do a soft reset by gently pressing the reset button with the tip of a paper clip. 

Every time I try to HotSync, I get an insufficient disk space error.

You must free up more space on your Macintosh's hard drive. It is recommended that users 
have at least 5MB of hard disk space available. 

How do I delete CS Setup from my Palm organizer? 

1. Select Memory from the Palm organizer menu. 

2. Choose Delete apps. 

3. Select CS Setup and tap Delete. 

4. Tap Yes to delete. 
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Synchronization

Synchronizing Your Palm Organizer With Your Offline 
Agenda

1. Synchronize the Palm organizer with your off-line Agenda. Agenda Entries are titled 
"A" on both. 

2. Upload your offline Agenda information to the calendar server. 

3. Synchronize your Palm organizer with your off-line Agenda. Set the Ctime Custom 
Action to Desktop Overwrites Palmtop. The Entry titled "A" now exists on both and has 
a Ctime Event ID. 

Why you might end up with duplicate Entries 

1. When you synchronize the Palm organizer with your offline Agenda, Agenda Entries 
are titled "A" on both. 

2. When you upload the data to the server, the server assigns Event ID "X" to "A". 

3. The next time you synchronize your on-line Agenda with the Palm organizer, you will 
end up with two Entries called "A". This is because the server does not recognize that 
the Entry with ID "X"is actually the same as the Palm organizer Entry titled "A". 

Synchronizing your Palm organizer with your online and 
offline Agenda 

1. Create your meetings, address book entries or tasks using your Palm. 

2. Then, synchronize your Palm organizer with your off-line Agenda. 

3. Log on to CorporateTime. 
zation 5-1



Synchronizing your Palm organizer with your online and offline Agenda
4. On the Options menu, select off-line, select Download and click Do not download. 
Then, click OK. 

5. When CorporateTime prompts Would you like to update the host Agenda?, click Yes. 

6. On the File menu, click Download To local file. 

7. Then, click OK when you are prompted Your are about to start downloading your 
agenda, would you like to continue? 

8. Open HotSync Manager, and select Custom. 

9. Click CorporateTime Addresses, select Change and then click Desktop overwrites 
handheld. Select the Set as default check box. Then, click OK. Now repeat step 8, for 
your CorporateTime Events and CorporateTime Tasks. Click Done when you are 
finished. 

10. Now synchronize your Agenda on-line. 

11. Then, change your CorporateTime Addresses, CorporateTime Events and 
CorporateTime Tasks to Synchronize the files. Then select the Set as default check box.

 

Note: To avoid creating duplicate entries, we recommend synchronizing 
your Palm with your online and offline Agenda after creating new 
Meetings, Address Book entries or Tasks on your Palm. 
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Field Mapping

This section describes the conversions that occur when transferring data between the 
calendar application and your Palm organizer's Date Book, Address Book and To Do List. 
Apart from the special conversion rules that apply to specific fields, some general rules 
apply: 

■ Text fields are cut to the maximum allowed length on the destination platform 

■ Dates that are not within the representable range of dates on the destination platform 
will get changed to the nearest representable date 

■ Details from the calendar application are truncated to the "maximum note size" before 
being sent to a Palm organizer note 

If the user changes a field on the Palm organizer which he or she does not have the 
right to change in the calendar application (e.g. changing the time of an Event the 
user does not own), the change is rejected and the affected field is copied from the 
calendar application back onto the Palm organizer. 

Entries
The following table shows how calendar application Entries are converted to Palm 
organizer Date Book items and vice versa.

Table 6–1 Calendar Application Entries and Palm Organizer Date Book Items

 Calendar Server 
Field Palm Field Notes

Title Description
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Entries
Location Description If the "Show Location" flag is set, the calendar 
server Entry's location is enclosed in 
parentheses and appended to the Palm Event's 
description, after its calendar server title. If the 
flag is not set, the calendar server Entry's 
location is ignored. 

Detail Note If the calendar server Entry is a Meeting, then 
its detail is copied to the Palm Event's note. If 
it is a Day Event or Daily Note, it is ignored. 
Also, if the "Show Location" flag is set and 
there is more than one attendee or its sole 
attendee is not the login user, then a textual 
list of attendee names is created and added to 
the Palm Event's note (which may or may not 
have been copied from the calendar server 
Entry's detail, depending on the Event's class). 

Start Time Date/Start Time The calendar server Entry's start time is split 
into two parts: the date and the time-of-day on 
that date. The date is always placed into the 
Palm Event's date field. If the calendar server 
Entry is a Meeting, then the time-of-day is 
placed into the Palm Event's start time. If the 
calendar server Entry is anything besides a 
Meeting (e.g. Day Event, Daily Note, 
Holiday), the Palm Event becomes an untimed 
Event. 

Duration End Time If the calendar server Entry is a Meeting, then 
its duration is added to its start time's 
time-of-day, and the result placed in the Palm 
Event's end time. The Palm does not allow 
Events to cross day boundaries. If that 
happens, the Event is truncated to end at 
midnight before being copied to the Palm (this 
does not affect the calendar server Entry). 

Table 6–1 (Cont.) Calendar Application Entries and Palm Organizer Date Book Items

 Calendar Server 
Field Palm Field Notes
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Tasks
Tasks
The following table shows how calendar application Tasks are converted to To Do 
items on the Palm organizer and vice versa.

Reminder Alarm If the calendar server Entry does not have a 
reminder, the Palm Event does not get one 
either and the calendar server Entry's 
reminder length is checked. If it is a multiple 
of 1440 (the number of minutes in a day) or is 
greater than 7620 (the number of minutes in 
127 hours), the Palm Event's alarm unit field is 
set to "Days". If it is a multiple of 60 or is 
greater than 127, the Palm Event's alarm unit 
field is set to "Hours" and the Palm Event's 
alarm unit field is set to "Minutes". The 
calendar server Entry's reminder length is 
then converted into the proper units. If the 
resulting number is greater than 127, it is 
changed to 127. This number is used in the 
Palm Event's alarm amount field. 

Access Level Private Flag If the calendar server Access level is Personal, 
the Palm Task's private flag is turned on. If the 
Access level is anything else, the Palm Task's 
private flag is turned off. 

Repeat Repeating Entries on the calendar server are 
always copied as individual instances, so this 
field is set to "No Repeat". 

Table 6–2 Calendar Server Tasks and Palm Organizer To Do Items

Calendar Server 
Field Palm Field Notes

Description Description

Detail Note

Table 6–1 (Cont.) Calendar Application Entries and Palm Organizer Date Book Items

 Calendar Server 
Field Palm Field Notes
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Address Book Entries
Address Book Entries
Address book Entries in the calendar application are categorized as business Entries and 
personal Entries on your Palm organizer. If a the calendar application Entry has a business 
address only (i.e. no home address), that Entry is considered a business Entry. Conversely, if 
the Entry has a home address only, it is considered a personal Entry. If an Entry has both 
addresses, its category is taken from the "Default" value in CS Setup. Finally, if an Entry 
does not have any addresses, it is considered an "unknown" Entry. 

The following table shows how a calendar application Address Book Entry is converted to a 
Palm organizer address and vice versa.

Priority Priority If the calendar server priority is 
between 1 and 5, it maps to the 
same priority on the Palm. If the 
calendar server priority is anything 
else, it maps to priority 5 on the 
Palm. 

Completion Level Completed Flag A calendar server completion level 
of 100% level flag maps to the 
Palm's completed flag being turned 
on. Any other completion level, the 
completed flag is turned off. 

Access Level Private Flag If the calendar server Access level is 
Personal, the Palm Task's private 
flag is turned on. If the Access level 
is anything else, the Palm Task's 
private flag is turned off. 

Category The To Do gets the default 
("Unfiled") category. 

Table 6–2 (Cont.) Calendar Server Tasks and Palm Organizer To Do Items

Calendar Server 
Field Palm Field Notes
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Address Book Entries
 

Table 6–3 Calendar Application Address Book Entries and Palm Organizer 
Addresses

Calendar Server 
Field Palm Field Notes

Category Business Entries in the calendar application 
are placed in the "Business" category. 
Personal Entries in the calendar application 
are placed in the "Personal" category. 
Unknown Entries are placed in the "Unfiled" 
category. 

Last Name Last Name

First Name First Name

Assistant Phone N/A

Business 1 A Phone field See below

Business 2 A Phone field See below

Fax 1 A Phone field See below

Fax 2 A Phone field See below

Home 1 A Phone field See below

Home 2 A Phone field See below

Mobile 1 A Phone field See below

Mobile 2 A Phone field See below

Page A Phone field See below

E-mail 1 A Phone field See below

E-mail 2 A Phone field See below

Street Address Business or home address, depending on 
Entry category. 

City City Business or home address, depending on 
Entry category. 

Prov/State State Business or home address, depending on 
Entry category. 

Zip Code Zip Code Business or home address, depending on 
Entry category. 
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Address Book Entries
Country Country Business or home address, depending on 
Entry category. 

Relationship N/A

Title Title

Company Company

Department N/A

Office N/A

Assistant N/A

Industry Type N/A

Account # N/A

Birthday N/A

Anniversary N/A

Custom Date 1 N/A

Custom Date 2 N/A

Nickname N/A

Spouse N/A

Personal Notes N/A

User 1 Custom 1

User 2 Custom 2

User 3 Custom 3

User 4 Custom 4

Notes Note

Private Flag Ignored. The calendar application currently 
does not support security on a per-address 
basis.

Table 6–3 (Cont.) Calendar Application Address Book Entries and Palm Organizer 
Addresses

Calendar Server 
Field Palm Field Notes
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Address Book Entries
Telephone fields on the Palm organizer are allocated according to a fixed order. For each 
telephone number present in the calendar application Entry, a telephone field on the Palm 
organizer is allocated (up to a maximum to five) and given a corresponding label.

For business and personal Entries, the order of allocation is as follows:

Palm organizer telephone numbers are transferred to the calendar application 
depending on (1) their position and (2) their label. For example, the second 
telephone with a label of "Mobile" will end up in the "Mobile 2" field in the calendar 
application. The complete list of possibilities is as follows:

Table 6–4 Palm Organizer Business and Personal Entries

Calendar Application 
Telephone # Palm Label

Business1 Work

Home 1 Home

Fax 1 Fax

E-mail 1 E-mail

Mobile 1 Mobile

Pager Pager

Business 2 Work

Home 2 Home

Fax 2 Fax

E-mail 2 E-mail

Mobile 2 Mobile

Table 6–5 How Palm Organizer Telephone Numbers Transfer to the Calendar 
Application

1st Occurrence on Palm Maps To

Work Business 1

Home Home 1

Fax Fax 1

Other N/A

E-mail E-mail 1
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Address Book Entries
Main N/A

Pager Pager

Mobile Mobile 1

Table 6–6 How Palm Organizer Telephone Numbers Transfer to the Calendar 
Application

2nd Occurrence on Palm Maps To

Work Business 2

Home Home 2

Fax Fax 2

Other N/A

E-mail E-mail 2

Main N/A

Pager N/A

Mobile Mobile 2

Table 6–5 (Cont.) How Palm Organizer Telephone Numbers Transfer to the Calendar 
Application

1st Occurrence on Palm Maps To
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